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1 Change History

Document Release Date Description

Version

V1.1.0 2025-01-06 Added the descriptions of the VX400 Pro, VX600 Pro and
VX1000 Pro.

V1.0.1 2024-12-16 Update Unico-related information.

V1.0.0 2024-12-10 First release
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2 Applications

The application diagram takes the VX2000 Pro as an example.

4K Layer 4K Layer

2K Layer 2K Layer 2K Layer

LED Screen

Long Distance

Transmission r 1
- e i et

DP |

Audie  Intelligent Central SDI HDMI
Console  Control Server Source Source  Source

B it
Control Cable Optical Fiber Cable ;
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3 Home Screen

This chapter takes the VX2000 Pro as an example.

3.1 Home Screen

Figure 3-1 Home Screen (VX2000 Pro)

1920x108
Internal

1920x1(

No. Content Description
1 VX2000 Pro The device name
a ® Hold down the knob and BACK

button simultaneously to lock or
unlock the front panel buttons.
® After the buttons are locked, all
the button operations will not
take effect and the & icon will
appear.
® After the buttons are unlocked,

the & icon will disappear.

192.168.0.10 The device IP address
2 ® |Layer 1 Displays the opened layer
® Layer 2 information, including the layer
o Layer 3 number, input source, input
resolution and frame rate
3 1920x1080@60 Displays the resolution and frame

rate of the configured screen.

The screen brightness

www.novastar.tech 8
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No. Content Description

4 e The Ethernet port is connected.
o The Ethernet port is not connected.
g ® The Ethernet port is connected

and serves as the backup output

port.
® When the backup icon at the

bottom flashes, there is data

transmission on the port.

5 Synchronization The sync function is enabled and the

synchronization succeeded.

The sync function is not enabled.

The sync function is enabled and the

synchronization is in progress.

The sync function is enabled but the

synchronization failed.

Display control The output is black.

The test pattern is shown.

The output image is displayed.

The output image is frozen.

‘0909090000

Connection The device is connected to the
method control PC via an Ethernet port.
] The device is not connected to the
control PC.
<3 The device is connected to the
control PC via a USB cable.
USB insertion Ce USB drive inserted.
status

O No USB drive inserted.

www.novastar.tech 9
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3.2 Second Home Screen

3.2.1 OPT Status Screen

When the device is in Video Controller mode, this page may vary according to the device
connected to the OPT port, as well as the OPT 3/4 working mode and the OPT loop mode.

® \When a fiber converter is connected to OPT 1/0PT 2, the port is used as an output
connector. The OPT status page displays the connection and backup statuses of the

Ethernet ports on the fiber converter connected to the VX2000 Pro, as shown in Figure 3-2.

Figure 3-2 OPT Status screen

® When a PIXELHUE video processor is connected to OPT 1/0PT 2, the port is used an input
connector. The OPT status page displays the resolution and frame rate of the accessed OPT
source and the connection and backup statuses of the Ethernet ports on the fiber converter
connected to the VX2000 Pro, as shown in Figure 3-3.

Figure 3-3 OPT input

® When OPT loop mode is enabled, the OPT status page is shown as follows.

www.novastar.tech 10
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Figure 3-4 OPT Loop

OPT1-1 1920x1080@60 OPT1-2 1920x1080@60

OPT LOOP

E Note

You can set the working mode of OPT 3 and OPT 4 to Copy or Backup. The OPT status screen

page will display the set working mode.

3.2.2 Fiber Converter Screen

When the device working mode is set to Fiber Converter, OPT 1~4 are all used for input and
Ethernet ports are used for output. OPT 1 and OPT 2 serve as the primary connectors, while
OPT 3 and OPT 4 serve as backup ones. The fiber converter screen page displays the data
transmission status of Ethernet ports on the fiber converter.

Figure 3-5 Fiber converter screen

11] [12] [13] (4] [35

o .: There is data transmission on Ethernet port.

° .: No data transmission on Ethernet ports

www.novastar.tech 1
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4 Menu Operations

E Note

Knob:

e On the home screen, press the knob to enter the operation menu screen.

e On the operation menu screen, rotate the knob to select a menu item and press the knob to

confirm the selection or enter the submenu.

e When a menu item with parameters is selected, you can rotate the knob to adjust the

parameters. Please note that after the adjustment, you need to press the knob again to

confirm the adjustment.

BACK: Exit the current menu or cancel an operation.

4.1 Screen Brightness

Screen brightness allows you to adjust the LED screen brightness in an eye-friendly way

according to the current ambient illuminance. Besides, the brightness parameters can be saved

to the receiving cards.

Prerequisites

The device is connected to a screen.

Screen Example

Main Menu

Screen Brightness
Screen Configuration
Layer Settings

Input Settings
Preset Settings

Display Control
USB Playback
Advanced Settings
System Settings
Factory Reset
Communication
Language

www.novastar.tech
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Operating Procedure

Step 1 On the home screen, press the knob to enter the main menu screen.
Step 2 Select Screen Brightness and press the knob to confirm the selection.

Step 3 Rotate the knob to adjust the brightness value. You can see the adjustment result on the LED

screen in real time. Press the knob to apply the brightness you set when you are satisfied with
it.

4.2 Screen Configuration

Screen configuration allows you to perform the following operations, including configuring the

screen, saving configuration to the receiving card and setting output mapping.

Figure 4-1 Screen configuration

Screen Configuration

Quick Configuration
Save to RV Card
Mapping

LED Screen Color

4.2.1 Quick Configuration

When the LED screen is a regular one composed of cabinets from the same batch, you can use

the quick configuration function to configure the LED screen.
Prerequisites

® The LED screen must be a regular one.
® The cabinets of the screen must be regular cabinets with the same resolution.

® The following data flow settings are supported. During data flow settings, ensure that each
port's physical connection is along the same direction and downward to the next one.

® During data flow settings, ensure that Ethernet Port 1 is at the beginning of the actual

physical connection.

www.novastar.tech 13
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Figure 4-2 Data flow

Notes

® Cabinets loaded by Ethernet port 1 = cabinets loaded by Ethernet port 2 = ... = cabinets
loaded by Ethernet port n ("n" represents the maximum port number.)

® The number of cabinets loaded by each Ethernet port must be an integer multiple of

Cabinet Row Qty or Cabinet Column Qty of the screen.

® The total pixels of the cabinets loaded by Ethernet port 1 cannot exceed 650,000.

Screen Example

Screen Configuration Quick Configuration

Cabinet Row Qty
Cabinet Column Qty
Port 1 Cabinet Qty
Data Flow (Front View)

Quick Configuration
Save to RV Card
Mapping

LED Screen Color

Operating Procedure

Step 1 On the main menu screen, rotate the knob to go to Screen Configuration > Quick

Configuration to enter the quick configuration screen.

Step 2 Set Cabinet Row Qty and Cabinet Column Qty according to the cabinets' actual row and

column quantities.

Step 3 Rotate the knob to select Port 1 Cabinet Qty to set the quantity of the cabinets loaded by
Ethernet port 1.

Step 4 Rotate the knob to select Data Flow (Front View) and press the knob to confirm. Select a
physical connection for the cabinets.

www.novastar.tech 14
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During data flow settings, you can see the result on the LED screen in real-time. If the entire
screen displays content correctly, that is, no overlapping or repetition, press the knob to save

the settings.

4.2.2 Save to RV Card

After the screen configuration information is sent to the receiving card, you can save the
configuration to the card by using this function so that the configuration data will not be lost

after a power failure.

Screen Example

Screen Configuration

Quick Configuration
Save to RV Card
Mapping

LED Screen Color

Operating Procedure

On the main menu screen, go to Screen Configuration > Save to RV Card and press the knob

to confirm.

4.2.3 Mapping

Mapping is used to show the relations between the cabinets of the LED screen and the sending

devices so that you can view or check the connections between the cabinets.

Notes

The receiving cards that are connected to the device must support the Mapping function. For
the supported models of the receiving cards, please visit our official website at

www.novastar.tech.

www.novastar.tech 15



NOVASTAR VX Pro Series All-in-One Controller User Manual

Screen Example

Screen Configuration

Quick Configuration
Save to RV Card
Mapping

LED Screen Color

Operating Procedure

On the main menu screen, go to Screen Configuration > Mapping and turn on the function.

Figure 4-3 Mapping

Example: S:01 stands for the sending card number, P:01 stands for the Ethernet port number
and #001 stands for the cabinet number.

4.2.4 LED Screen Color

This function allows you to adjust the color temperature and Gamma value of the LED screen to

make the images displayed on the screen more clear and vivid.

www.novastar.tech 16
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Screen Example

Screen Configuration

Quick Configuration
Save to RV Card

Mapping

LED Screen Color

Operating Procedure

LED Screen Color

Gamma 2.8
Color Temperature Mode  Standard
Color Temperature (K) 6500

Reset

On the main menu screen, go to Screen Configuration > More Settings to enter the screen

color settings screen.

® Select Gamma and press the knob to confirm. Rotate the knob to adjust the Gamma value

and press the knob to confirm when you are satisfied with it.

® Rotate the knob to select Color Temperature Mode and press the knob to confirm. Rotate

the knob to adjust the temperature mode, including Standard, Cool, Warm and Custom,

and then press the knob to confirm when you are satisfied with it.

When Custom is selected, you can customize the color temperature value.

Parameter Descriptions

Parameter Description
Gamma Adjust the image distortion degree from the input to output. The greater the value is,
the more distorted the image will be.
The value ranges from 0.25 to 4.00 and defaults to 2.8.
Color Adjust the cool or warm degree of images displayed on the LED screen. When
Temperature Custom is selected, you can customize the color temperature value.
Mode

www.novastar.tech
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NOVASTAR

4.3 Layer Settings

4.3.1 Add Layers

Notes

The maximum number of layers that can be added depends on the connected device.

Device Model Number of Supported Layers (2Kx1K)
VX2000 Pro 12

VX1000 Pro 6

VX600 Pro 6

VX400 Pro 6

Screen Example

Layer Settings

Layer No.
Layer Status
Input Source
Scaling Mode
H Width

V Height

Layer 1 (4K)
[ ]

HDMI 1 (4K)
Full Screen
3840

2160

Initial X
Initial Y
Z-Order
Input Crop
3D

Operating Procedure

Step 1 On the home screen, press the knob to enter the main menu screen.
Step 2 Rotate the knob to select Layer Settings and press the knob to enter the layer settings screen.

Step 3 Rotate the knob to select Layer No. and press the knob to display the layer list.

Q Note

e In the layer list, both the current opened layers and the layers to be opened are displayed.
e Layer name displayed in the layer list: Opened layer: Layer n (capacity), unopened layer: Layer
n, and “n” represents the layer number.

www.novastar.tech 18
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Step 4 Rotate the knob to select the desired layer number and press the knob to confirm.
Step 5 Rotate the knob to select Layer Status and press the knob to turn on the switch.
Step 6 Rotate the knob to select Input Source and select the desired input source for the layer.

Step 7 Rotate the knob to select other layer parameters and set them if needed. The layer parameter

descriptions are shown in Figure 4-4.

Figure 4-4 Layer parameter descriptions

LED Screen
Initial Y

Initial X

H Width (1920)

Step 8 Rotate the knob to select Z-Order and set the layer z-order.

The greater the priority number is, the higher priority the layer has.

4.3.2 Set Layer Properties

Parameter Descriptions

Table 4-1 Layer properties

Menu Description
Layer No. The layer number
Layer Status Open or close the layer

Q Note

By default, layer 1 is opened and uses the first input source.

Input source Select an input source for the current layer.

a Note

www.novastar.tech 19
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Menu

Description

Press an input source button in the SOURCE area on the device front panel

to quickly select an input source for the layer.

Scaling Mode

The layer supports the following three scaling modes.
® Full Screen: The layer image fills the whole screen.

® Pixel to Pixel: The layer image is not scaled but displayed in the original

size of the input source or the cropped source.

® Custom: Customize the layer size and the output image is scaled

according to the layer size.

H Width

Set the layer size in the horizontal direction.

The width value ranges from 64 to 131070.

V Height

Set the layer size in the vertical direction.

The height value ranges from 64 to 131070.

Initial X

Set the horizontal distance between the top left corner of the layer and the

top left corner of the screen.

The value ranges from -250000 to 248080.

Initial Y

Set the vertical distance between the top left corner of the layer and the top

left corner of the screen.

The value ranges from -250000 to 248080.

Z-Order

The layer priority

® Up: Bring the selected layer forward.

® Down: Send the selected layer backward.

® Top: Bring the selected layer to the front.

® Bottom: Send the selected layer to the back.

Input Crop

Crop the input source image and display the cropped part on full screen.
® Status: Turn on or turn off the function.

® H Width: The size of the copped part in the horizontal direction

® V Height: The size of the copped part in the vertical direction.

® |nitial X: Set the start position for the cropping in the horizontal direction.

The value defaults to 0.

® |nitial Y: Set the start position for the cropping in the vertical direction.

The value defaults to 0.

3D

Turn on or turn off the function.
e On: @
e Off: (OB
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4.3.3 Input Crop

This function allows you to crop the input source image and make the cropped part display on
full screen.

Prerequisites
A fine signal is connected to the input connector.
Notes

® The status and capacity of the cropped source remain consistent with the original one.

® The input cropping and 3D functions cannot be enabled at the same time.

Screen Example

Input Crop

Status [ Resolution:
H Width 1920 3840%2160

VHeight 1080 E
Initial X 0

Initial Y 0

Operating Procedure

Step 1 On the home screen, press the knob to enter the main menu screen.
Step 2 Go to Layer Settings > Input Source and press the knob to display the input source list.
Step 3 Rotate the knob to select the desired input source and press the knob to confirm.

Step 4 Rotate the knob to select Input Crop and press the knob to enter the input source cropping

screen.
Step 5 Select Status and press the knob to turn on the function.

Step 6 Rotate the knob to configure the cropping parameters and set them if needed. The cropping
parameter descriptions are shown in Table 4-1 and Figure 4-5.
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Figure 4-5 Input crop effect
T

Input Source: 1920x1080@60Hz Layer Size: 1920x1080

4.4 Input Settings

The input settings allow you to switch the input connector capacity, set input resolution and

InfoFrame override parameters, as well as configure mosaic sources.

Figure 4-6 Input settings

Input Settings

Input Source HDMI 1
Capacity 4K
Input Resolution  3840x2160@60Hz
InfoFrame Override >
MQOSAIC >

4.4.1 Switch Connector Capacity

Switch the input connector capacity to allow the device to calculate the number of layers that

can be added based on the capacity.
Prerequisites

You have selected an input source.
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Notes

Changing the connector capacity of the OPT source is not supported.

Screen Example

Input Settings

Input Source
Capacity

Input Resolution
InfoFrame Override
MOSAIC

Operating Procedure

Step 1 On the input settings screen, rotate the knob to select Input Source and press the knob to

display the input source list.
Step 2 Rotate the knob to select the desired input source and press the knob to confirm.
Step 3 Rotate the knob to select Capacity and press the knob to display the capacity list.

Descriptions of the connector capacity:
® SL:1920x1080@60Hz
e DL: 3840x1080@60Hz

® 4K: 3840%x2160@60Hz

Step 4 Rotate the knob to select the target capacity and press the knob to confirm.

4.4.2 Set Input Resolution

Set the input resolution and frame rate. The options include Standard and Custom.
Prerequisites

® The front-end device outputs the video source from the graphics card.
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® You have selected an HDMI or DP source. SDI does not support this function.

Screen Example

Figure 4-7 Standard resolution

Standard
Resolution 3840x2160
Frame Rate 60

Input Resolution

Current Resolution 3840x2160@60Hz
Standard >
Custom >
Import EDID >
Export EDID >

Figure 4-8 Custom resolution

Custom
Width
Height

Input Resolution
Current Resolution 3840x2160@60Hz
Standard >
Custom >
Impart EDID >
Export EDID >

Frame Rate

Operating Procedure (Standard Res)

Step 1 On the input settings screen, select the desired input source and press the knob to confirm.
Step 2 On the input resolution settings screen, select Standard.
Step 3 Rotate the knob to select Resolution, and press the knob to show the resolution list.

Step 4 Rotate the knob to select the desired resolution from the list and then press the knob to

confirm.

Step 5 Rotate the knob to select the desired frame rate from the list and then press the knob to
confirm.

Step 6 Rotate the knob to select Apply and press the knob to complete the standard resolution

settings.
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Operating Procedure (Custom Res)

Step 1 On the input settings screen, select the desired input source and press the knob to confirm.
Step 2 On the input resolution settings screen, select Custom.

Step 3 Rotate the knob to select Width and press the knob to confirm. Rotate the knob again to select

the desired width and press the knob to confirm.

Step 4 Rotate the knob to select Height and press the knob to confirm. Rotate the knob again to select

the desired height and press the knob to confirm.

Step 5 Rotate the knob to select Frame Rate and press the knob to show the frame list. Rotate the

knob again to select the desired frame rate and press the knob to confirm.

Step 6 Rotate the knob to select Apply and press the knob to complete the custom resolution settings.

4.4.3 Import and Export EDID

If you encounter a compatibility problem with an input connector, you can resolve it by
importing a compatible EDID file into the device. You can also export an EDID file from the

device and providing it to other devices or input connectors.
Prerequisites

® Before importing the EDID file, you have saved the file (.bin and .dat) to the root directory in
an USB drive and inserted it into the device USB port.

® Before exporting the EDID file, you have inserted an USB drive into the device USB port.

® You have selected an accessed input source. SDI connector does support this function.

Notes

® Each input connector supports importing one EDID file only.

® Once the EDID file is imported, the input connector will recognize and apply the parameters

from the file.
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Screen Example

Input Resolution

Current Resolution 3840x2160@60Hz
Standard >
Custom >
Import EDID >
Export EDID >

Operating Procedure (Import EDID)

Step 1 On the input resolution settings screen, rotate the knob to select Import EDID and press the
knob to enter the EDID file list screen.

Step 2 Select the desired file and press the knob to confirm

Step 3 In the popup dialog, select OK to import the EDID file.

Operating Procedure (Export EDID)

Step 1 On the input resolution settings screen, rotate the knob to select Export EDID and press the
knob to enter the EDID file exporting screen.

Step 2 Select the file format (.bin or .dat) and press the knob to confirm.

Step 3 Select Apply to apply the parameters saved in the file.

E Note

If you need to modify the content of an imported EDID file, just modify it and then re-import it to

overwrite the original one.

4.4.4 Configure InfoFrame Override Parameters

Set the InfoFrame override parameters for the input source, allowing the device to use them

during calculations. This won't alter the input source's original parameter values.
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Parameter Description

You have selected an HDMI or DP source. SDI does not support this function.

Screen Example

InfoFrame Override
Color/Sample (N/A)

From Input

Quantization Range (N/A) From Input

Operating Procedure

Step 1 On the input settings page, rotate the knob to select InfoFrame Override and press the knob

to enter the corresponding screen.

Step 2 Rotate the knob to set the color/sample of the input source and press the knob to confirm.

Step 3 Rotate the knob to set the quantization range of the input source and press the knob to

confirm.

Parameter Descriptions

Menu

Description

Color/Sample

The sampling format of the input

Quantization Range

The quantization range of the input

The supported options include From Input, Limited and Full.

E Note

Select From Input and the device will read the attribute values that come with

the input source.
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4.4.5 Configure Mosaic Sources

Both HDMI and OPT sources support mosaicing.

Notes

® Only the VX2000 Pro supports this function.

® Only the input sources of the same connector type support mosaicing, and the frame rates

of sub-source must be the same.

Screen Example

MOSAIC
Source Type HDMI 1.3
Layout I
Width 1920
Height 1080

HDMI 3 HDMI 4

Mosaic Size: 3840x1080

Reset Apply

Make sure that frame rate of each source must be the same,
otherwise issues such as mosaic image tearing may occur

Operating Procedure

Step 1 On the input settings screen, rotate the knob to select MOSAIC and press the knob to enter the

mosaic source settings screen.
Step 2 Rotate the knob to select Source Type and press the knob to confirm.
Step 3 Select the desired mosaic layout.
Step 4 Set Width and Height for each mosaic area.

® [f the input source width or height is less than the width or height value you set, the blank

area will be filled with solid black.

® [f the input source width or height is larger than the width or height value you set, the input
source image will be cropped. The cropping takes the top left corner of the input source
image as the reference point and then crops the image according to the set width and

height values.

® The total width and height of the mosaic source will be displayed.
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Step 5 Rotate the knob to select the mosaic layout area and press the knob to select sub-sources of

each mosaic area.

Step 6 Rotate the knob to select Apply to make the settings take effect; otherwise, select Reset to
reset the settings to defaults.

Parameter Descriptions

Parameter Description

Source type The connector type of the sub sources

The supported options include HDMI 2.0, HDMI 1.3 or OPT.

Q Note

Each OPT port supports transmission of 2x SL or 1x DL source.

Layout The mosaic layout

The layout varies depending on the source type.

® For HDMI 2.0, three layouts are supported: " .", "[." and "

® For HDMI 1.3, eight layouts are supported: ".", "E.", ";", "l]", "=",
AT e

® For OPT, eight layouts are supported: ".", "[I", ":", "l]", "=", "ﬂ",
m and "=

Width The width of the individual mosaic area

Default value: 1920 pixels

Height The height of the individual mosaic area

Default value: 1080 pixels

Mosaic Size The size of the mosaic source

® Max. width: 8192 pixels

® Max. height: 8192 pixels

® Max. width and height: 4096x2160

a Note

The mosaic source capacity depends on the max capacity and number of sub-sources, that is, the

capacity of a mosaic source composed of two DL sub-sources or SL+4K sub-sources is 4K.

www.novastar.tech 29



VX Pro Series All-in-One Controller User Manual

NOVASTAR

4.5 Preset Settings

A preset is a set of parameters that save the layer and layer-related information. The VX Pro
series supports 256 user-defined presets. After a preset is saved, you can load the preset simply
by its name. The preset operations include Save, Load and Delete.

Screen Example

Figure 4-9 Preset settings

Preset Settings
[001 Preset 1
002 Preset 2
003 Preset 3
Preset 4
005 Preset 5

Preset 6
Preset 7
Preset 8
Preset 9
Preset 10
Preset 11

4.5.1 Save Presets

After the layer settings, you can save those settings as a preset.

Screen Example

Preset Settings
[001) Preset 1
002 Preset 2
003| Preset 3
Preset &4
Preset 5

Preset é
Preset7
Preset 8
Preset9
010 Preset 10
1l Preset 11

Preset Settings

[007 Preset 1
0

8 X

Save Load

0

[4]
009 Preset 9
D10 Preset 10
011 Preset 11

Operating Procedure

Step 1 On the preset settings screen, rotate the knob to select a preset.
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Step 2 Press the knob to open the preset operations window.
Step 3 Rotate the knob to select Save and press the knob to save the layer settings to this preset.

After a preset is saved, the preset status on the right side changes to Saved.

4.5.2 Load Presets

This operation allows you to send a saved preset to an LED screen.

Screen Example

Preset Settings
[001 Preset 1
002 Preset 2
003 Preset 3
Preset 4
005| Preset 5

Preset Settings

(001 Preset 1
0]

<
Load

Preset &
Preset7
Preset 8
Preset ¢
010 Preset 10
011 Preset 11

0
0
009 Preset 9

010 Preset 10
011 Preset 11

Operating Procedure

Step 1 On the preset settings screen, rotate the knob to select a saved preset.
Step 2 Press the knob to open the preset operations window.
Step 3 Rotate the knob to select Load and press the knob to load the preset.

After a preset is loaded, the preset status on the right side changes to In Use.

E Note

Press the PRESET button on the front panel to quickly enter the preset setting screen. You can
press a number button to quickly load the corresponding preset.

4.5.3 Delete Presets

This operation allows you to clear the data saved in the preset. The preset name will not be
cleared.
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Screen Example

Preset Settings
[001 Preset 1
002 Preset 2
003 Preset 3
Preset &4
Preset 5

Preset é
Preset7
008 Preset 8
Preset9
010 Preset 10
Preset 11

Preset Settings

(0017 Preset 1
0

0

[4]
009 Preset 9
D10 Preset 10
011 Preset 11

Operating Procedure

Step 1 On the preset settings screen, rotate the knob to select a saved preset.
Step 2 Press the knob to open the preset operations window.
Step 3 Rotate the knob to select Delete and press the knob to open a confirmation window.

Step 4 Rotate the knob to select Yes and press the knob to delete the preset.

4.6 Display Control

Notes
If the freeze or FTB function is turned on, the test pattern function is unavailable.

Screen Example

Display Control

Normal
Freeze

FTB

Test Pattern

Qutput Color
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Parameter Descriptions

Menu Sub-Menu Description
Normal - Display the content of the current input source.
Freeze - Freeze the current frame of the output image.
FTB - Make the output image fade to black.
Test Pattern | Pure Color The pure color test pattern

Gradient The gradient test pattern

Grid The grid test pattern

Brightness The brightness of the test pattern

Spacing Level

Set the spacing between different color areas.

If a multi-color test pattern is selected, this parameter is

available.

Spacing (px)

Set the spacing between the lines.

If a grid test pattern is selected, this parameter is available.

Line Width

Set the width of the grid lines.

If a grid test pattern is selected, this parameter is available.

Speed

Set the moving speed of the lines.

If a grid test pattern is selected, this parameter is available.

Output

Color

Brightness

The shading of lights in the image

Adjust the brightness value either as a whole or individually

adjust the RGB components.

Contrast

The ratio of the luminance of the brightest color to that of the

darkest color

Adjust the contrast value either as a whole or individually adjust

the RGB components.

Saturation

The color purity of the image

The higher the value, the more vivid the color.

Hue

The relative degree of how bright or dark the image is
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4.7 USB Playback

Play images or videos saved in a USB drive and configure the playback parameters. A USB

source can be used as a layer source.

The models of devices that support USB playback and the corresponding output resolutions for

USB sources are listed below.

Device Model USB Source Resolution
VX2000 Pro 3840%x2160@60Hz
VX1000 Pro 1920x1080@60Hz
VX600 Pro

VX400 Pro

E Note

Press the desired layer button in the LAYER area on the device front panel and then press the U-

DISK button to use a USB source to open a layer.

4.7.1 USB Player

Prerequisites
A USB drive has been inserted and recognized in the U-DISK connector on the front panel.
Notes

Up to 128 files can be displayed in the playlist and the size of each file cannot exceed 128 GB.
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Screen Example

USB Playback
USB Player

USB Player
1. Media 01.png
2.Media 02.png
3. Media 03.mp4
4. Media 04.mp4

Playback Settings

Unplayed

Operating Procedure

Step 1 On the main menu screen, go to USB Playback > USB Player to enter the USB player screen.

Step 2 Rotate the knob to select the desired the file and press the knob to play the file or stop the
playback.

The items displayed on this screen are as follows.
® Media files in compatible formats

® The playback mode

® The playback status

® The volume level

4.7.2 Playback Settings

Configure the playback-related parameters.

Screen Example

USB Playback
USB Player
Playback Settings

Playback Settings
Playback Mode Loop
File Type All
Image Playback Duration (s) 5
Image Transition Effect Ripple

Image Trans Duration (s) 0.5
Auto Playback ®
Resume Playback ®
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Limitations

® Single-partition USB drive supported
® File system: NTFS, FAT32 and exFAT
® Max. width and height of media files
Width: 3840 pixels, height: 2160 pixels
® Picture format: jpg, jpeg, png and bmp
® Decoded image resolution: 3840x2160 or lower
® Video format: mp4
® Video coding: H.264, H.265
® Max. video frame rate:
H.264: 3840x2160@30fps, H.265: 3840x2160@60fps
® Audio coding: AAC-LC

® Audio sampling rate: 8kHz, 16kHz, 44.1kHz, 48kHz

Parameter Descriptions

Parameter Description

Playback Mode The playback mode of the file

® | oop: Play the files in the playlist in order. Once the playback of the last file
is completed, replay the first file.

® Play in Order: Play the files in the playlist in order. Once the playback of the
last file is completed, the screen will display a black image and the playback

will stop.

® Repeat One: Loop playback of the current file.

File Type The type of the playback file
® Video
® Image

® All: Video and Image

E Note

After the file type is selected, only the file of the selected type will be displayed
in the playlist.

Image Playback The duration of the image playback
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Parameter

Description

Duration (s)

The value ranges from 1 to 60 and it defaults to 5. (Unit: s)

Image Transition
Effect

The trans effect of the image

Supported trans effect: Ripple, zoom in, push, flip, blinds, H wipe, V wipe,
cube, dissolve, grid, swapping, scroll, fade in/out, twirl, heart trans, curtains,

perspective triangle, disappear, bounce, star rotation

Image Trans Duration

(s)

The trans duration of the image

The value ranges from 0.5 to 2 and it defaults to 0.5. (Unit: s)

Auto Playback

Set whether to automatically play the USB files after the device is powered off

and then power on with a USB drive inserted.

e @:0n
If Resume Playback not enabled, replay the files in the playlist in order; If
enabled, replay the file being played before power failure from the
beginning.

o CI: Off

Resume Playback

® On: If a file is playing before the device power failure, enabling this function
allows to replay the file from beginning after the device is powered on with
a USB drive inserted.

® Off: Replay the files in the playlist in order.

E Note

® Enabling Resume Playback will also activate the Auto Playback feature at

the same time.
* After Resume Playback is enabled, if the file being played before power
failure cannot be found, the files will be played from the beginning of the

playlist in order.

4.8 Advanced Settings

4.8.1 End-to-End Backup

The end-to-end backup is supported, including device backup, input source backup and

Ethernet port backup test, stable and reliable.

4.8.1.1 Device Backup

The backup between devices and Ethernet ports are both supported.
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4.8.1.1.1 Backup Between Devices

Device backup allows you to set the backup relationship between two devices. You can set one
of the devices as the primary device or the backup device. When the primary device has a
problem or the primary device's Ethernet cable fails, the backup device will take over the
responsibilities of the primary device seamlessly and continue to work well to ensure the LED

screen will not go black.

Prerequisites

® Before creating a backup relation, make sure that both the primary and backup devices are

on the same LAN.

® In a backup relation, the models and device versions of the primary and backup devices must

be the same.

Notes

® You have three options to create a backup relation: NovaLCT, Unico web page, or the device
LCD menu. However, be aware that these methods do not synchronize with each other.
Using more than one can lead to data problems. To prevent issues, choose only one method
for setting up your backup. If you do mix them, you'll need to reset the device to factory

settings and start over with just one method.

® |n the device backup mode, the quantity of the cabinets loaded by each Ethernet port on
both the primary and backup devices must be the same, but their data flow must be in a

reversed way.

Hardware Connections

The diagram takes the VX2000 Pro as an example.
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LED Screen

g

[ ]

———
Control PC

==
Video Source

Screen Example

End-to-End Backup
Device Backup

Device Backup
Device Backup Primary

Backup IP Primary
Backup

Input Backup
Ethernet Port Backup Test

Operating Procedure

Step 1 On the main menu screen, go to Advanced Settings > End-to-End Backup > Device Backup to

enter the device backup screen.
The available devices on the same LAN will be automatically searched.
Step 2 Set the primary device.

Step 3 Rotate the knob to select Backup IP and press the knob to display the backup IP list. Select the

desired IP address of a device to be set as a backup one.

E Note

After a backup relation is created, the configuration parameters (except communication settings)

of the primary device will be automatically synchronized to the backup device.
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4.8.1.1.2 Backup Between Ethernet Ports

Ethernet port backup allows you to set the backup relationship between two Ethernet ports.
When the primary port has a problem or the primary port's Ethernet cable fails, the backup port
will take over the responsibilities of the primary port seamlessly and continue to work well to
ensure the LED screen will not go black. When setting the backup between the Ethernet ports,

you need to complete it in NovaLCT.

Hardware Connections

This diagram takes the VX2000 Pro as an example.
LED Screen

o o ]

Video Source
Operating Procedure

Step 1 Run the NovalCT software. On the menu bar, go to User > Advanced Synchronous System
User Login. Enter the password and click Login.

Step 2 Click Screen Configuration to enter the screen configuration page.

Step 3 Click Next to enter the screen configuration page.
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Figure 4-10 Screen configuration

Screen Configuration-COM$9
Sending Card  Receiving Card  Screen Connection
Display Mode
L)

Current Display Mode

Sending Card 277 Graphics Output R. 1920 x 1080 Curre. 272
Select Input Source

Video Input 3D Function .

[ Automati + |send [ Enable [ settings

Source Confiquration

Source HOMI ~

Resolution 1920x1080px v [ Custom... 1920 5| x [1080

RefreshRate T |gp ~ Hz InputSource BitDe.. |8Bi L P

L
Hot Backup Verification
| verty

Redundancy —

Setthe Current Devi... [] Setas Primary [] Setas Backup ‘*

Primary Backup
ie”a‘ N‘g"bs”‘f Serial Number of S;”i' N‘g’“”;”'f Serial Number of
nimary sending Primary Port ackup Sending Backup Port
Card Card

| Refech | Send (it | | Bt | | oBaletey

Restare Factor. ExportScreen .| |Save System Co.| | Save | | Ciose

Step 4 Select the Sending Card tab, and then click Add in the Redundancy area.
Step 5 Set the serial numbers of both the primary device and backup device to 1.

Step 6 Set the serial number of the primary port and the serial number of the corresponding backup

port.

Figure 4-11 Ethernet port backup

4k

Serial Mumber of Primar.. |1 = Serial Number of Backu... 1

Serial Mumber of Primar... |4 = Serial Mumber of Backu... " $
o Add | Close
Step 7 Click Add to complete the backup settings of an Ethernet port, and the system will
automatically list the primary ports and backup ports.
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Figure 4-12 Primary Ethernet ports

Screen Configuration-COM9% - [m] X

Sending Card  Receiving Card  Screen Connection

Display Mode

 Refresn |
Current Display Mode
Sending Card 272 Graphics Output R. 1920 x 1080 Curre. 222
Select Input Source
Video Input ) 3D Function ) .
[ Automati v ‘“ [ Enable Settings
Source Configuration
Source: HOMI v
Resolution 1920x1080px  ~ [J Custom.. 1920 5| x[1080
RefreshRate T gp ~| Hz Input Source BitDe... |8Bi v
\‘*
Hot Backup Verification -
\‘*
Redundancy .
Setthe Current Devi... [ ] Setas Primary [] Setas Backup ‘*
Primary Backup

Serial Number of
Backup Sending

Serial Number of

Serial Number of
Primary Sending erial Number o

Backup Port

Serial Number of

Card Primary Port Card

»

bttt st (] (| (S

[Restore Factor | Bwponsueen. sawsysemco. | sae | - cise |

Step 8 Repeat Step 6 and Step 7 to complete the backup settings for other Ethernet ports.

4.8.1.2 Input Backup

Input backup allows you to set the backup relationship between two input sources. When one
input source has a problem or the input connector fails, the backup source will be used

seamlessly and continue to work well to ensure the LED screen will not go black.

Notes

Input backup rules:

® |n each backup group, two input sources serve as the backup for each other.

® Only the source from the same type of input connector can be set as the backup source.
® FEach primary or backup source can have only one backup or primary source.

® Restrictions on input backup functions:

Input sources A and B form a hot backup group. The current input source of the layer is

input source A.
- Input A: No signal. Input B: Signal

The layer input source is switched to input B automatically. When input A resumes and
input B still has a signal and Primary Source Preferred is not enabled, the layer input

source will not be changed.
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- Input A: No signal. Input B: Signal

The layer input source is switched to input B automatically. When input A resumes, but

input B does not have a signal, the layer input source will be changed to input A.
- Input A: No signal. Input B: No signal

The layer input source will not be changed.
- Input A: Signal. Input B: No signal

If you manually switch the layer input source to input B, the source will automatically
switch to input A.

Screen Example

End-to-End Backup

Device Backup

Input Backup
Input Backup
Input Backup

Primary Source Preferred

Primary
HDMI 1
N/A
N/A

N/A

Ethernet Port Backup Test

Operating Procedure

Step 1 On the main menu screen, go to Advanced Settings > End-to-End Backup > Input Backup to

enter the input backup settings screen.
Step 2 Rotate the knob to select Input Backup and press the knob to turn on the function.
Step 3 Rotate the knob to select the desired primary input source on the left side.
Step 4 Rotate the knob to select the desired backup input source on the right side.
Step 5 (Optional) Set the primary source preferred.

® On: The primary source will always be used if there is a signal. When the primary source fails,
the layer input source is switched to the backup one automatically. Once the primary source

resumes, the layer input source seamlessly switches back to the primary source.

e Off: The layer input source will be switched to the primary source only when the backup one

fails and the primary one has a signal.
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4.8.1.3 Ethernet Port Backup Test

Test whether the pre-stored images, backup Ethernet ports and devices take effect without

plugging and unplugging the Ethernet cables.
Prerequisites

The pre-stored images, primary and backup Ethernet ports or primary and backup devices have
been configured.

Screen Example

End-to-End Backup
Device Backup >
Input Backup >
Ethernet Port Backup Test Off
Off

Backup Only
Primary Only
Disconnect All

Parameter Descriptions

Parameter Description

Off Enable the output of all the Ethernet ports on the current device to
complete the test.

Backup Only Disable the output of the primary Ethernet port on the current device to test

whether the backup port or device takes effect.

Primary Only Disable the output of the backup Ethernet port on the current device to test

whether the output of the primary port is normal.

Disconnect All: Disable the output of all the Ethernet ports on the current device to test

whether the pre-stored image takes effect.

www.novastar.tech 44



NOVA STAR VX Pro Series All-in-One Controller User Manual

4.8.2 Synchronization

This function allows you to select a synchronization signal to synchronize all the cascaded
device units or synchronize the primary and backup devices to display the output images of all

the units in sync.
Notes

® The input source with or without signal can be used as a sync source. When a no signal

source is used, the sync fails.
® Synchronizing to a DP source is supported by the VX2000 Pro only.

® Before enabling the Genlock sync function, make sure the sync signal has been connected to

the Genlock connector of the device.

Screen Example

Synchronization

Status Succeeded.
Sync To HDMI 1
Sync Frame Rate 60.00

Operating Procedure

Step 1 On the main menu screen, go to Advanced Settings > Synchronization to enter the

synchronization settings screen.

Step 2 Rotate the knob to select Sync To and press the knob to display the sync source list. The
options include Internal, HDMI X/DP/SDI and Genlock. ("X" represents the input source

number and its format may vary depending on the actual setup.)

® Internal: The frame rate of the output image

e HDMI X/DP/SDI: Sync with the frame rate of the selected input source. After a sync source is
selected, the sync frame rate will be displayed.

® Genlock: Sync with the frame rate of the Genlock signal.
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Step 3 (Optical) If Internal is selected, you can manually set the output frame that defaults to 60Hz.

Once the synchronization is successful, the screen will show Succeeded.

4.8.3 Audio Settings

This function allows you to set the audio status, output audio and volume.
Hardware Connections

The diagram takes the VX2000 Pro as an example.
® Via a multifunction card

Connect the Ethernet port 1 or 2 to a multifunction card, and then connect the multifunction

card to an external speaker.

LED Screen

Multifunction

®
Card

Speakert ﬁ

® Viathe audio output connector

Connect the audio output connector to an external speaker.
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LED Screen

w

peaker

©

©

Screen Example

Audio
Status

Qutput

Volume

4.8.3.1 Set Audio Status

Turn on or turn off the audio, and adjust the output and volume settings as needed.

Screen Example

Audio
Status
Qutput

Volume
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Operating Procedure

Step 1 On the main menu screen, go to Advanced Settings > Audio to enter the audio settings screen.
Step 2 Rotate the knob to select Status and press the knob to confirm.

Step 3 Rotate the knob to select On or Mute to turn on or turn off the audio.

4.8.3.2 Select Output Audio

Set to play which audio on the external audio.
Notes

Only the VX2000 Pro supports output of the accompanied audio that comes from a DP
connector.

Screen Example

Audio
Status Mute

Qutput HDMI 2

Volume AUDIO IN

HDMI 1
HDM| 2
HDMI 3
HDMI 4
HDMI 5
HDMI 6
DP

U-DISK

Operating Procedure

Step 1 On the main menu screen, go to Advanced Settings > Audio > Output and press the knob to
display the output audio list.

Step 2 Select the desired output audio and press the knob to confirm.

AUDIO IN: Output the analog audio that comes from an external audio device.

HDMI: Output the accompanied audio that comes from an HDMI connector.

DP: Qutput the accompanied audio that comes from a DP connector.

U-DISK: Output the audio of a USB source.
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4.8.3.3 Set Output Volume

Adjust the output volume.

Screen Example

Audio
Status
Qutput

Volume

Operating Procedure

Step 1 On the main menu screen, go to Advanced Settings > Audio to enter the audio settings screen.

Step 2 Rotate the knob to select Volume and press the knob to confirm. Then rotate the knob again to

adjust the audio volume and press the knob to confirm.

Parameter Descriptions

Parameter

Description

Volume

The output volume

The value ranges from 0 (silent) to 100 (loudest) and defaults to 50.

4.8.4 Low Latency

When the input source travels from where it comes to the processing device, sending device

and then the receiving card, latency exists inevitably. Turning on this function can effectively

help to reduce the latency from the input to output.
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Notes

To enable low latency, please make sure all Ethernet ports load the cabinets vertically and share
the same Y coordinate. Free screen configuration (for example, Ethernet port 2 loads cabinets
horizontally, or its Y coordinate is different from that of Ethernet port 1) will reduce the load

capacity.

Operating Procedure

On the main menu screen, go to Advanced Settings > Low Latency and press the knob to
confirm. Then rotate the knob again to turn on or turn off the function and press the knob to
confirm.

4.8.5 3D

Directly connect a third-party 3D emitter using the device's built-in 3D connector, or connect to
the EMT200 emitter via the device's Ethernet port. Then, use the compatible 3D glasses to
achieve a 3D display effect.

Prerequisites

® Video source format: Side-by side, top-and-bottom or frame sequential

® When paired with the EMT200, it is recommended to use a 3D source of 60Hz to enjoy an

optimal experience.

Notes

® Enabling the 3D function will halve the device output capacity.

® The 3D function and input cropping cannot be enabled at the same time.
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® After enabling the 3D function on the advanced settings screen, 3D switches of all the layers
will be toggled on. If you want to use a 2D layer, please toggle off the 3D switch of the

desired layer on the layer settings screen.

® The 3D effect follows the layer. The output area where a 3D layer is located always displays
the 3D effect.

Hardware Connections

The diagram takes the VX2000 Pro as an example.

% 4

Shutter 3D Glasses

Screen

EMT200

Input Signal

Screen Example

3D Settings
Status [

Video Source Format  Side-by-Side
Eye Priority Left
Enable Third-Party Emitter [}

Signal Delay (us)

Turning on 3D mode will halve the device cutput capacity|
Pay attention to the cabinet connection.

Operating Procedure

Step 1 On the main menu screen, go to Advanced Settings > 3D Settings > Status to turn on the

function.
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Step 2 Select the 3D format of the video source. The options include Side-by-Side, Top-and-Bottom

and Frame Sequential.
Step 3 Set the eye priority. The options include Left and Right.
Step 4 (Optional) Turn on the Enable Third-Party Emitter switch.

Step 5 Set the signal delay duration.

The value ranges from 0 to 20000 and defaults to 7000. (Step: 1, unit: us)

4.8.6 Working Mode

Setting device and OPT wording modes are both supported.

4.8.6.1 Device Working Mode

Three working modes are supported, including Video Controller, Fiber Converter and ByPass.

Screen Example

Device Mode

Working Mode

Device Mode Fiber Converter

OPT Mode Video Controller

ByPass

Parameter Descriptions

Table 4-2 Fiber converter

Device Model Description
VX2000 Pro Optical fiber ports are used for input, and Ethernet ports are used for
output.

® OPT 1~4 are used for input, and Ethernet ports are used for output.

® OPT 1 and OPT 2 serve as the primary connectors. The Ethernet ports
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Device Model

Description

1~10 transmit OPT 1 data, and Ethernet ports 11~20 transmit OPT 2 data.

® OPT 3 and OPT 4 serve as the backup connectors.

VX1000 Pro

Optical fiber ports are used for input, and Ethernet ports are used for

output.
® OPT 1~2 are used for input, and Ethernet ports are used for output.

® OPT 1 serves as the primary connectors. The Ethernet ports 1~10 transmit
OPT 1 data.

® OPT 2 serves as the backup connectors.

VX600 Pro

Optical fiber ports are used for input, and Ethernet ports are used for

output.
® OPT 1~2 are used for input, and Ethernet ports are used for output.

® OPT 1 serves as the primary connectors. The Ethernet ports 1~6 transmit
OPT 1 data.

® OPT 2 serves as the backup connectors.

VX400 Pro

Optical fiber ports are used for input, and Ethernet ports are used for

output.
® OPT 1~2 are used for input, and Ethernet ports are used for output.

® OPT 1 serves as the primary connectors. The Ethernet ports 1~4 transmit
OPT 1 data.

® OPT 2 serves as the backup connectors.

Table 4-3 Video controller

Device Model Description
VX2000 Pro ® OPT 1 and OPT 2 can be used as an input or output connector depending
on the connected devices.
® OPT 1 and OPT 2 send the output on Ethernet ports 1~10 and 11~20
respectively. OPT 3 and OPT 4 copy or back up the output on Ethernet
ports 1~10 and 11~20 respectively.
VX1000 Pro ® OPT 1 can be used as an input or output connector depending on the
connected devices.
® OPT 1 sends the output on Ethernet ports 1~10. OPT 2 copies or backs up
the output on Ethernet ports 1~10.
VX600 Pro ® OPT 1 can be used as an input or output connector depending on the
connected devices.
® OPT 1 sends the output on Ethernet ports 1~6. OPT 2 copies or backs up
the output on Ethernet ports 1~6.
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Device Model Description

VX400 Pro ® OPT 1 can be used as an input or output connector depending on the

connected devices.

® OPT 1 sends the output on Ethernet ports 1~4. OPT 2 copies or backs up
the output on Ethernet ports 1~4.

Table 4-4 ByPass

Device Model Description
VX2000 Pro/VX1000 Under this mode, the device works as an independent controller with no
Pro/VX600 Pro/VX400 | support for video processing functions.
Pro
4.8.6.2 OPT Mode

Supports settings of both the OPT working mode and loop mode.

Screen Example

Working Mode

Device Mode

OPT Mode

OPT Mode
OPT 3/4

OPT Loop

Hardware Connections

The diagram takes the VX2000 Pro as an example.
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Figure 4-13 Copy mode

LED Screen LED Screen

Ethernet Cable Ethernet Cable

Video Controller
HDMI Cable Optical Fiber Cable
Ll
HDMI Source

Figure 4-14 Backup between Ethernet and OPT ports

LED Screen

m  Data flow of primary Ethemet ports

* Data flow of backup Ethernet ports
Note:

If the Ethemnet port of the device in video controller

mode fails, the LED screen can still work normally:

www.novastar.tech 55



NDI/ASTAR VX Pro Series All-in-One Controller User Manual

Figure 4-15 OPT loop mode

LED Screen

Video Controller

Ethernet
-

Cable
1 e ] [ ]
HDMI Source =S NN |
'"HDMI Cable
n:’ Optical Fiber Cable
PIXELHUE Switcher

Optical Fiber Cable

LED Screen

Video Controller

Parameter Descriptions

Table 4-5 OPT working mode

Device Model Parameter Description

VX2000 Pro OPT 3/4 ® Copy: OPT 3 copies the output on Ethernet ports 1~10,
and OPT 4 copies the output on Ethernet ports 11~20.

® Backup: OPT 3 backs up the output on Ethernet ports
1~10, and OPT 4 backs up the output on Ethernet ports

11~20.
VX1000 Pro OPT 2 ® Copy: OPT 2 copies the output on Ethernet ports 1~10.
® Backup: OPT 2 backs up the output on Ethernet ports
1~10.
VX600 Pro ® Copy: OPT 2 copies the output on Ethernet ports 1~6.

® Backup: OPT 2 backs up the output on Ethernet ports 1~6.

VX400 Pro ® Copy: OPT 2 copies the output on Ethernet ports 1~4.

® Backup: OPT 2 backs up the output on Ethernet ports 1~4.

Table 4-6 OPT loop mode

Device Model Parameter Description

VX2000 OPT Loop Loop out the video signal accessed by OPT 1 via OPT 2 for
Pro/VX1000 device mosaic.

Pro/VX600

e @D): Enable the loop mode.
Pro/VX400 Pro

www.novastar.tech 56



NOVASTAR VX Pro Series All-in-One Controller User Manual

Device Model Parameter Description

e (ID: Disable the loop mode.

4.8.7 HDCP Status

High-bandwidth Digital Content Protection (HDCP) is a form of digital copy protection to
prevent copying of digital audio and video content as it travels across connections. When the
accessed input source is an HDCP-encrypted one, you need to turn on this function to enable

the device to transmit and process the source.

Parameter Descriptions

Parameter Description

HDCP Status Turn on or turn off the function.
e @:0On
o (ID: Off

4.8.8 Monitor Settings

Real-time display of the output image via the monitor connected is supported. You can monitor
whether the output is normal and adjust the display ratio of the monitoring image on the

monitor to avoid image distortion.

Notes

The output resolution of the monitor connector is fixed at 1920%x1080@60Hz.

Parameter Descriptions

Parameter Description

Monitor Settings The options include Keep Ratio and Full Screen (default).
® Keep Ratio: Keep the ratio of the original output image to display.

® Full Screen: Display the output image in full screen.

E Note

When Keep Ratio is selected, the blank area that the output image cannot
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Parameter Description

cover the entire monitor screen will be automatically filled with solid black.

4.9 System Settings

49.1Fn

This function allows you to set a shortcut button for an assigned function. By using the Fn
button, you can quickly navigate to the target menu screen and never need to access a
specified menu item by entering the menus level by level.

Screen Example

Fn

Synchronization

Freeze
FTB
Test Pattern

Operating Procedure

Step 1 On the main menu screen, go to System Settings > Fn press the knob to enter the Fn button
settings screen.

Step 2 Rotate the knob to select the desired function and press the knob to confirm.

4.9.2 Return to Home
Operating Procedure

Step 1 On the main menu screen, go to System Settings > Return to Home and press the knob to
confirm.
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Step 2 Rotate the knob to select the desired time value and press the knob to confirm.

Parameter Descriptions

Parameter Description

Return to Home You can set the period when the system stays at the current screen before
returning to the homepage automatically when there is no operation

performed.

The value ranges from 60s to 3600s

4.9.3 Diagnostics

The diagnostics function helps you to diagnose the system and troubleshoot the malfunctioned
device components. When the device fails, you can run the diagnostics function to test the
device. You can send your test to our technical support staff for problem locating and
processing. For daily maintenance, you can run the diagnostics function to do the routine health
check for the system.

Notes

Running diagnostics will transiently disrupt the output, and the output will resume after the

diagnostics are completed.
Operating Procedure

Step 1 On the main menu screen, go to System Settings > Diagnostics and press the knob to enter

the diagnostics screen.
Step 2 Rotate the knob to select Run Diagnostics and press the knob to confirm,

Step 3 In the popup dialog, rotate the knob and select Yes and press the knob to confirm.

4.9.4 Export Logs

Export the device logs to a USB drive to quickly identify issues.
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Prerequisites
Before exporting logs, you have inserted a USB drive into the USB port on the device.
Operating Procedure

Step 1 On the main menu screen, go to System Settings > Log Export to enter the log exporting
screen.

Step 2 Rotate the knob to select Apply and press the knob to confirm. The log file will be exported to
the root directory of the USB drive.

4.9.5 Update Device

Import the update file saved in a USB drive to the device for quick update.
Notes

During the update process, power-off and all operations are NOT allowed.
Operating Procedure

Step 1 On the main menu screen, go to System Settings > Update to enter the device update screen.
Step 2 Rotate the knob to select the update file and press the knob to confirm.

Step 3 In the popup dialog box, rotate the knob to select OK and press the knob to confirm. Then wait
for the device to automatically complete the update.

4.9.6 Cascading ID

Set the device cascading ID which is the unique identification when the device is in a cascading
link.

Notes

® The cascading ID defaults to 1 and can be changed manually. You need to set an ID for each
cascading device in order.
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® After you set IDs successfully, connect devices using Ethernet cables based on the set ID.

Parameters Description

Parameter Description

Cascading ID When multiple devices are cascaded, you need to set a virtual ID for each

device, ensuring that the devices displayed in NovalLCT match with actual

devices.

4.9.7 About Us

Under this menu item, you can view the firmware version, device SN, official website and email
address. On our official website, you can check the latest device information and the updates
for this device. You can also send your feedback or suggestion to us for improvements via the

supplied email address.

Screen Example

About Us

Firmware Version: V1.0.0

SN:202411131839456

Website: www.novastar-led.cn

Email: support@novastar.tech

4.10 Factory Reset

Factory reset function allows you to reset all the parameter settings of the device to factory

defaults after the device update or when you think the parameters are improperly set.
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Screen Example

Factory Reset

Keep User Data

£ Input EDID, scommunication, Fn, imported files and device name

Reset All

Parameter Descriptions

Parameter Description

Keep User Data Reset the parameter settings to factory defaults, except for the Input EDID,

communication, Fn, imported files and device name.

Reset All Reset all the parameter settings to factory defaults.

4.11 Communication Settings

You can set the communication and network information to enable the device to communicate

with the control PC smoothly.

Screen Example

Communication

Network Mode Manual
IP Address 192.168.0.10

Subnet Mask 255.255.255.0
Gateway 192.168.0.1

MAC de:90:1d:d9:11:29

Resetl  Apply
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Operating Procedure

Step 1 On the main menu screen, rotate the knob to select Communication and press the knob to

enter the communication settings screen.
Step 2 Select Network Mode and press the knob to confirm.

The options include Manual and Automatic.
® Manual: Set the device IP address, subnet mask and gateway manually.

® Automatic: The system automatically assigns an IP address for the device. When the device

and control PC are connected to the same router or switch, set this option to Automatic.

Step 3 When the Manual option is selected, you must manually set the device IP address, subnet mask
and gateway.

Step 4 Rotate the knob to select Apply to make the settings take effect; otherwise, select Reset to
reset the settings to defaults.

4.12 Language

The language options include English and Simplified Chinese. You can switch to your preferred

language.
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5 Web Page Control
5.1 Web Page Control

5.1.1 Connection

The control computer can connect to the device in the following two ways:
® Via Ethernet cable

Connect the device and the control PC directly via Ethernet cable and set a static IP address

for the device to let it and the control PC be on the same network segment.
® ViaLAN

Connect the device and the control PC to the same LAN to ensure that both of them are on

the same network segment.

5.1.2 Enter Web Control Page

Prerequisites

You have completed the connection between the device and control PC.

Notes

When the device is connected directly to a control PC via an Ethernet cable, the device and
control PC must be on the same network segment and their IP addresses cannot conflict. For
example, if the device IP address is 192.168.0.10, the IP address of the control PC must be
192.168.0.X and X cannot be 10.

Description

Enter the device IP address into your browser's address bar and press Enter. The web page

appears.
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5.2 Project Management

5.2.1 Create New Projects

All the online devices on the same LAN will be automatically added to a default project. Users

can create a new project and remove the desired device from the default project to the new
one.

Step 1 Select Projects on the left side of the interface to show the project list.

Figure 5-1 Project list

Projects

e Projecis ||  Simusation Projects

Step 2 Click New Project on the Online Projects tab interface.
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Figure 5-2 Create online projects (VX2000 Pro)

New Project

Project Name | Projects 1

Project Type Oniine Projects Simulation Projects

Device List (1 items) Selected Devices (0 items)

Device 1
192.163.0.108

VX2000 Pro  InUse

Step 3 Name the project.

Step 4 Select the devices that you want to include in the project, and click Add.

a Note

A device can be added to one project only.

Related operations are as follows:

® Remove: Withdraw the selected devices in Selected Devices list to Device List.
o Add All: Add all the devices in Device List to Selected Devices list.

® Remove All: Withdraw all the devices in Selected Devices list to Device List.

Step 5 After the settings, click OK.

After a project is successfully created, you will enter the device configuration interface.

a Note

In the project list area, you can perform the following project-related operations:

e Rename project: Hover the mouse over the desired project and click that appears on the

right side of the project name.
e Enter project: Click Enter in the Action column.
o Edit project: Click Edit in the Action column.
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o Delete project: Click Delete in the Action column.
e View project details: Click Details in the Action column.

5.2.2 Import Projects

Import the local project files (.uprj) to the device. Please note that the device models must
match with the models in the project file.

Step 1 Select Projects on the left side of the interface to show the project list.
Step 2 Click Import Project or go to File > Import.
Step 3 In the dialog box that appears, select a project file (.uprj) and click OK.
Step 4 In the displayed Import Project File window, select Online Projects.
Figure 5-3 Import project files
Import Project File

Online Projects Simulation Projects

Mailching List

Device in File Online Device Matching Result Parameters

System1 System1 - Resource Files
The device is being used by..
10.10.90.120 10.10.90.120 Device Parameters

Step 5 After successful device matching, select the data to be imported and click OK.

The system matches the SN, name, IP address, model, and firmware version from the file with
the online device.

Click and select other online devices from the drop-down menu.
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5.2.3 Export Projects

Export the device project files to your local computer.
Step 1 Select Projects on the left side of the interface to show the project list.

Step 2 Select the Online Projects tab, double-click the project name or click Enter in the Action
column to enter the device configuration interface.

Step 3 In the menu bar, select File > Export.
Step 4 In the displayed dialog box, select the desired data.

Figure 5-4 Export project files

Export Project File

rce files include BKG, LOGO, OSD, internal source, 3D

Device Parameters

Resource Files

Step 5 Click Export.

Step 6 In the displayed dialog box, select a file path and click Save.

5.3 Device Management
5.3.1 Enter Device Configuration Page

5.3.1.1 Online Devices

Step 1 Select Devices on the left side of the interface to show the device list.
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Figure 5-5 Online device list (VX2000 Pro)

Device List

Onine Devices | Simutaon Devices

Step 2 (Optional) Switch the display style of the device list as desired.
o Bl Graphical view
- View the device name, IP address and model.

- Double clicking the device front panel image allows you to access the device
configuration interface.

Device 1
10.10.91.189 | VX2000 Pro

L] E: List view
- View the device name, IP address, model, and the project the device belongs to.
- Inthe Action column, you can access the device configuration interface.

- Place the mouse over the device information and click that appears on the right

side of the device name to change the device name.

Step 3 Perform either of the following actions to enter the device configuration page.

® |n the graphic view mode (, double click the image of the device front panel.

® |n the list view mode (E), click Enter in the Action column.
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5.3.2 Configure Device Properties

Select the device on the left side of the device configuration interface, and then configure the
device-related properties on the right pane.

Figure 5-6 Device properties (VX2000 Pro)

Fle Mo semngs  How
< Bac

Projects 1

Device Information

® 303 £307 0303 307 0303 £307 £307 £30) 0303 303
oBRe %92 @

I — N — N — e —
P11 MOM2D MOMIZD  MOWLI  HOMILI HOMIL3 WOWIL3

5.3.2.1 Rename Device

Change the device name.
Prerequisites

None
Notes

None
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Interface Example

Device Name Device 1
Firmware Version V1.0.0
Device SN outmani01091139

MAC Address 54:B5:6C:59:59:59

Working Mode Video Controller

Description

Enter a name for the device in the text box next to Device Name.

a Note

In the device list on the left side of the interface, you can also right click the device name and

select Rename from the context menu to change the device name as well.

5.3.2.2 Switch Working Mode

Switch the device working mode.
Prerequisites
None
Notes
Set the device working mode according to the on-site application and screen connections.

Interface Example

Device Name Device 1
Firmware Version V1.0.0
Device SN outmani01091139

MAC Address 54:B5:6C:59:59:59

Working Mode Video Controller
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Description

Select Video Controller, Fiber Converter or ByPass from the drop-down list.

5.3.2.3 Configure IP Address

Manually set a static IP address for the device or let the device to automatically obtain an IP
address.

Prerequisites
None
Notes
None

Interface Example

v Network Settings

Network Mode Manual

IP Address

Subnet Mask

Gateway

Description

Configure the following parameters and click Apply to make the settings take effect.

Parameter Description

Network Mode Select the IP configuration method.
® Manual: Manually set a static IP address for the device.

® DHCP: The device automatically obtains an IP address.

IP Address The device IP address

Subnet Mask The subnet mask of the IP address
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Parameter Description

Gateway The default gateway

5.3.2.4 Configure Sync Source

Select a sync signal to synchronize all the cascaded device units or synchronize the primary and

backup devices to display the output images of all the units in sync.

Prerequisites

Before enabling the Genlock sync function, make sure the sync signal has been connected to

the Genlock connector of the device.

Note

None

Interface Example

v Synchronization

screeni Successful

Sync To Internal Frame Rate

Frame Rate 60.00

Description

Parameter Description

Sync To Select a sync source.
® Internal Frame Rate: The frame rate of the output image
® DP/HDMI X/SDI: Sync with the frame rate of the selected input source.

"X" represents the input source number and its format may vary depending on

the actual setup.
® Genlock: Sync with the frame rate of the Genlock signal.

When the function is enabled, the frame rate of the sync source will be displayed.

Frame Rate When you select Internal Frame Rate, you can manually set the output frame
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Parameter

Description

rate. The default value is 60Hz.

5.3.2.5 Configure HDCP

High-bandwidth Digital Content Protection (HDCP) is a form of digital copy protection to

prevent copying of digital audio and video content as it travels across connections. When the

accessed input source is an HDCP-encrypted one, you need to turn on this function to enable

the device to transmit and process the source.

Prerequisites
None
Notes
None

Interface Example

v HDCP
Input [ ]
Description
Parameter Description
HDCP Turn on or turn off the function.

o« @:0n
o (I Off

5.3.2.6 Configure Date and Time

Configure the time zone, date and time of the device.
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Prerequisites
None
Notes
None
Interface Example
v Time
Time Zone (UTC-+08:00) Asia’Shanghai

Date 2024-11-27

Time 17:05:21

(" Edt )

Description

Click Edit and the parameters become editable. Set the time zone, date and time respectively,
and then click Apply.

5.3.2.7 Configure Input Source Backup

Establish a backup relation for two input sources.
Prerequisites

None
Notes

® The backup relation can only be established if the input connectors have identical capacities.
® Once the function is enabled, the switching of the connector capacity is not supported.

® In the Manual mode, use the designated source only regardless of signal availability. In the
Auto mode, adhere to the following principles when the primary source transitions from no

signal to signal presence:
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- If Primary Source Preferred is selected, automatically switch to the primary source.

- If Primary Source Preferred is not selected, continue using the backup source.

Interface Example

v Input Source Backup

Primary Source Preferred @

JL

Primary Source Backup Source

* HDMI 1 v « HDMI 2

Description

Step 1 Set the Input Source Backup switch to .
Step 2 Select or deselect Primary Source Preferred.
Step 3 Click IEM.

Step 4 Select a primary source and a backup source respectively from two drop-down lists to establish

a hot backup pair.
The green dot @ indicates the source is accessed normally and ready for use.

® To delete a hot backup pair, click . next to the pair and click Delete.

® To delete all hot backup pairs, click El

Step 5 Click . on the right and set Mode to either Auto or Manual.

If Manual is selected, you will also need to choose the desired source.

5.3.2.8 Reset to Factory Settings

Reset the device data and settings to factory default values.

Prerequisites

None
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Notes

Please do this with great caution.

The reset action does not affect the device firmware version.

Power-off is not allowed during the reset process.

The device will restart automatically after the reset is completed.

Interface Example

~ Factory Reset

Keep user data &

Reset all

Description

Select Keep user data or Reset all, and then click Apply.
® Keep user data

Retain the device IP address, input connector EDID, gallery files, language settings, device

name and belonged project.
® Reset all

Retain the device IP address and belonged project.

5.3.2.9 Restart Device

Restart the device.

Prerequisites

None

Notes

None
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Interface Example

Description

Click Restart, and then click Yes in the displayed dialog box.

5.3.3 Configure Input Properties

Click the target input connector on the graphical device rear panel, and then set the input-

related properties in the property area on the right pane.

Figure 5-7 Input properties (VX2000 Pro)

Input Properties

Basic

v Source Information

VX2000 Pro

él'_'ll'_'l 00 OO0 OO0 00 00 00 00 00 00
mcodfle 298 @ |-

5.3.3.1 View Input Source Info

View the basic properties of the input connector and change the input connector name.

Prerequisites

A fine signal is connected to the input connector.
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Notes
None

Interface Example

~ Source Information

Connector Name HDMI 2

Type HDMI 1.3
Resolution (&) 1920=1080 px

Frame Rate 59.94 Hz
Bit Depth Bbit
Color/Sample RGE 4:4:4
Color Gamut Rec.709
Quantization Range Full
Dynamic Range SDR
HDCP Off

Description

On the Basic tab interface, change the connector name as required.

5.3.3.2 Set OPT Ports

Set the OPT working mode and loop mode.
Prerequisites

The device working mode is set to Video Controller.
Notes

None

Interface Example

OPT Settings

OPT3/4 Working Mode:

OFT LoopMode
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Description

Table 5-1 OPT working mode

Device Model Parameter Description
VX2000 Pro OPT 3/4 Working | OPT 3 and OPT 4 working modes
Mode

Config method: Select Copy or Backup from the drop-down
list.

® Copy: OPT 3 and OPT 4 copy the output on Ethernet port
1~10 and 11~20 respectively.

® Backup: OPT 3 and OPT 4 back up the output on Ethernet
port 1~10 and 11~20 respectively.

VX1000 Pro OPT 2 Working OPT 2 working mode

Mode Config method: Select Copy or Backup from the drop-down

list.
® Copy: OPT 2 copies the output on Ethernet port 1~10.

® Backup: OPT 2 backs up the output on Ethernet port
1~10.

VX600 Pro OPT 2 working mode

Config method: Select Copy or Backup from the drop-down
list.

® Copy: OPT 2 copies the output on Ethernet port 1~6.
® Backup: OPT 2 backs up the output on Ethernet port 1~6.

VX400 Pro OPT 2 working mode

Config method: Select Copy or Backup from the drop-down
list.

® Copy: OPT 2 copies the output on Ethernet port 1~4.
® Backup: OPT 2 backs up the output on Ethernet port 1~4.

E Note

o After the OPT working mode is set to Copy, the OPT ports on the graphical device panel will be
highlighted.

o After the OPT working mode is set to Backup, the backup icons will be displayed at the bottom
right corner of the OPT ports on the graphical device panel.
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Table 5-2 OPT loop mode

Pro/VX400 Pro

Device Model Parameter Description

VX2000 OPT Loop Mode Turn on or turn off the function.
Pro/VX1000 e On @

Pro/VX600

After this function is enabled, the video signal accessed
by OPT 1 will be looped out via OPT 2.

o Off: (B

5.3.3.3 View OPT Source Info

View the basic properties of the OPT source and change the OPT port name.

Prerequisites

® The device working mode is set to Video Controller.

® OPT 1 and OPT 2 is connected to the OPT ports on the front-end video processor via optical

fiber cables. Additionally, a fine signal is connected to the front-end device.

Notes

Each OPT support the transmission of 1x DL or 2x SL sources.

Interface Example

Input Source

~ OPT1-1

Connector Name
Type
Resolution &
Frame Rate
Color/Sample

> OPT1-2

> OPT2-1

> OPT2-2

OPT11

OPT
1920=1080 px
60 Hz

RGE 4:4:4
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Description

On the Input Source tab interface, change the connector name as required.

5.3.3.4 Set Input Connector Capacity

Switch the input connector capacity as desired.
Prerequisites
Notes
Interface Example
When a connector is configured for hot backup, you can no longer switch its capacity.

Interface Example

Capacity SL
Description
Parameter Description
Capacity Select the desired connector capacity from the drop-down list.
® 4K: 4Kx2K
® DL: 4Kx1K
® SL: 2Kx1K

5.3.3.5 Configure InfoFrame Override Parameters

Configure the InfoFrame override parameters of the input source, so that the device can use it
when doing some calculations. This action does not change the parameter values that come

with the input source.
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Prerequisites
None
Notes
None
Interface Example

Vv InfoFrame Override

Color/Sample From

Bit Depth From

Quantization Range | From

Description

Input

Input

Input

On the Basic tab interface, configure the following parameters.

Parameter

Description

Color/Sample

The sampling format of the input

Bit Depth

The bit depth of the input, i.e., the binary digits to represent a single color

Quantization

Range

The quantization range of the input

Select From Input and the device will read the attribute values that come with the input source.

5.3.3.6 Configure EDI

D

Configure the resolution and frame rate of the input. You can select the standard resolution

provided by the device, customize a resolution, or set the advanced parameters.

Prerequisites

® SDI does not support this function.

® The front-end device outputs the video source from the graphics card.
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Notes

It is recommended the advanced settings be carried out by the trained personnel only.

Interface Example

Input Properties

Basic
v EDID

Resolution

Frame Rate

Advanced
H Total
H Active
H Front Porch

H Sync

H Polarity

V Total

V Active

V Front Porch
V Sync

V Polarity

Description

1920x1080

60.00

On the EDID tab interface, configure the following parameters and click Apply after the

settings.

Parameter | Sub-Parameter Description

Resolution | - The number of horizontal pixels and vertical pixels of the image
Config method:
® Select the desired resolution from the drop-down list.
® Select Custom from the drop-down list, and then set the width

and height values respectively.
Frame - The image frames every second (unit: Hz)
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Parameter | Sub-Parameter Description
Rate Config method: Select the standard common frame rates from the
drop-down options. The available frame rates may vary according
to the chosen resolution.
Advanced | H Total Total pixel count per line
H Active The horizontal size in pixels of the active area

H Front Porch

The offset between the end of the active area and the beginning

of the H sync

H Sync The horizontal sync width in pixels (or between pixels)
H Polarity The polarity of the horizontal sync pulse

V Total Total pixel count per column

V Active The vertical size in pixels of the active area

V Front Porch

The offset in lines between the end of the active output area and

the beginning of V sync

V Sync

The vertical sync width in rows (or between rows)

V Polarity

The polarity of the vertical sync pulse

5.3.3.7 Import and Export EDID

When compatibility problem occurs on an input connector, import an intact EDID file into the

device; or export an EDID file from a device and provide the EDID file to other devices or input

connectors to solve the compatibility issues.

Prerequisites

SDI does not support this function.

Notes

® Each input connector supports importing one EDID file only.

® Once the EDID file is imported, the input connector will recognize and apply the parameters

from the file.
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Interface Example

v EDID Import/Export

EDID Import EDID Export

Description

® EDID Import

On the EDID tab interface, click EDID Import. In the dialog box that appears, select an EDID
file and click Open.

® EDID Export

On the EDID tab interface, click EDID Export. In the dialog box that appears, select a path

and click Save.

Q Note

If you need to modify the content of an imported EDID file, just modify it and then re-import it to

overwrite the original one.

5.3.3.8 Configure Compatibility with Mac

When the device is incompatible with the EDID of a Mac system, you may activate this feature

to resolve the issue.
Prerequisites

None
Notes

None

Interface Example

Compatibility &
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Description
Parameter Description
Compatibility Turn on or turn off the function.
o« @:0n
o (B off

5.4 Screen Configuration

5.4.1 Configure Screen Topology

Configure the cabinet topology to complete the physical wiring connections of the cabinets on

the screen.

5.4.1.1 Configure Online Cabinets

Prerequisites
The device is connected and cabinets are connected to the device.
Operating Procedure

Step 1 Select a device on the left side of the interface and then click Screen at the top of the page.
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Figure 5-8 Screen configuration (VX2000 Pro)

Screen Properties

Step 2 Select an Ethernet port at the bottom and then drag and click the mouse in the topology area
to add cabinets.

The cabinets will be automatically connected when you are adding them, as shown in Figure 5-

9. The Ethernet port's loading capacity information will be displayed, as shown in Figure 5-10.
Figure 5-9 Cabinets connected automatically

Device 1

® 2/3:Indicates that there are three cabinets connected to Ethernet port 1 and 2 of which are
added to the topology.

® 12.66%: Indicates these two cabinets have used 12.66% of the Ethernet port capacity.
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E Note

o Swift Layout: If all the cabinets loaded by the Ethernet ports have the same model, resolution,
and connection topology, you can use the Swift Layout function to quickly add and connect
the cabinets for all the Ethernet ports.

e Operating procedure: Click and then drag the mouse in the topology area to add
cabinets that match the actual requirements. In the properties area, select a layout and click
Done.

Step 3 Select other Ethernet ports and continue to add cabinets until all cabinets are connected.

Step 4 For cabinets that have the same size and consecutive serial numbers, if you want to change the
cabinet connection topology, select the cabinets and then select a quick topology under Quick

topo in the properties area, as shown in Figure 5-11. For other cabinets, skip this step.

Figure 5-11 Quick topology

Quick Topo

Step 5 Do any of the following to arrange and align the cabinets and cabinet groups to let the cabinet
positions meet the display requirements.

® Use the function buttons.

Zoom to Selection Grid chd Cabinet Align Left Locked/Unlocked

0

T | |

ZoomIn Zoom Qut Auto Fit Clear Topology Arrange Left

- Zoom to Selection: The selected element is zoomed and displayed in the center of the

canvas.

- Auto Fit: The canvas size is automatically adjusted to fit the topology area size.

- Click

canvas grid.

&l to show its drop-down menu shown below. The menu can be used to set the
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Snap to Cabinet

Snap to Grid

Grid: When toggled on (#), a grid is displayed on the canvas. If you do not need to
display the grid, set the switch to .

Grid Color: Set the grid color.

Grid Spacing: Set the spacing of horizontal and vertical lines of the grid. The spacing is

set to the resolution of the first cabinet by default.

Snap to Cabinet: When positioning a cabinet near another one, the cabinet being
moved will automatically align and snap to the edge of the adjacent cabinet, effectively

eliminating gaps.
Snap to Grid: The cabinet will be snapped to the grid.
- Add Cabinet: Add online cabinets or cabinets in the cabinet library.
® Use the right-click function menu

- Select String: Select all the cabinets on the connection line of the current cabinet.

Change Model: Change the model of the current cabinet.
-~ Select Same Cabinets: Select the cabinets of the same model of the current cabinet.

- Blackout: Blackout the output image displayed on the current cabinet.

Freeze: Freeze the output image displayed on the current cabinet.

Swap: Swap the positions of the two selected cabinets.

- Group: Select the desired cabinets and right click on them. Click Group in the context
menu, and then the selected cabinets will be grouped for batch control. To set the
group name and color, please select the group and set them in the properties area. You

can also use the keyboard shortcuts Ctrl+G to perform the grouping operation.

- Ungroup: Ungroup the cabinets. You can also use the keyboard shortcuts Ctrl+Shift+G
to perform this action.

Add to: Add the selected cabinets to a group.
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- Clear Topology: Clear the current cabinet topology.

- Delete: Delete the selected cabinet. You can also use the keyboard shortcuts Del to
perform this action.

® Right click on the canvas edge and use the function menu

Fit Screen

Zoom 1:1

Display Grid

Snap to Gnd

Snap to Cabinet
Display Topology
Display Status
Display Cabinet Color

Display Group Name

Display Overlapping Cabinets

- Zoom to Selection: The selected element is zoomed and displayed in the center of the

canvas.

- Fit Screen: The canvas size is automatically adjusted to fit the topology area size.
- Zoom 1:1: The canvas size equals the input source resolution.

- Display Grid: Display a grid on the canvas.

- Snap to Grid: The cabinet will be snapped to the grid.

- Snap to Cabinet: When positioning a cabinet near another one, the cabinet being
moved will automatically align and snap to the edge of the adjacent cabinet, effectively
eliminating gaps.

- Display Topology: Display the cabinet connections.
- Display Status: Display the cabinet status.
Green: The cabinet is in the canvas area.
Gray: The cabinet is offline.
Orange: Some part of the cabinet is in the canvas area.

Red: The entire cabinet is out of the canvas area.
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- Display Cabinet Color: Display a color icon at the top right corner of an Ethernet port.
Once an Ethernet port is loading cabinets, a color icon will be displayed which is of the

same color as the cabinet color.
- Display Group Name: Display the cabinet group name.

- Display Overlapping Cabinets: Display the overlapping cabinets.

Figure 5-12 Online cabinet topology (VX2000 Pro)

Q Note

e Use either Unico web page or NovalLCT to configure the screen.

e Mapping is used to show the relations between the cabinets of the LED screen and the
sending devices so that you can view or check the connections between the cabinets.

e Inthe menu bar, go to File > Export Screen Config File to export the configured cabinet
topology as a file (.scr).

e Inthe menu bar, go to File > Import Screen Config File to import a saved screen configuration

file for quick topology.

5.4.2 Configure Screen Properties

Set the screen-related properties in the property area on the right pane.

5.4.2.1 Rename Screens

Change the screen name.
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Prerequisites
None
Notes
None

Interface Example

v Screen

Screen Name screent
Screen category LED Screen
Resolution @ 576*216

Low Latency [ ]

Processor Latency (D)

Description

On the Basic tab interface, enter a new screen name, and then click elsewhere in the interface
to complete the screen name change.

5.4.2.2 Configure Low Latency

When the input source travels from where it comes to the processing device, sending device
and then the receiving card, latency exists inevitably. Turning on this function can effectively
help to reduce the latency from the input to output.

Prerequisites
None
Notes

To enable low latency, please make sure all Ethernet ports load the cabinets vertically and share
the same Y coordinate. Free screen configuration (for example, Ethernet port 2 loads cabinets
horizontally, or its Y coordinate is different from that of Ethernet port 1) will reduce the load
capacity.
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ILED Display

Interface Example

v Screen

Screen Mame screen

Screen category LED Screen

Resolution @ 576* 216

Low Latency [ ]

Processor Latency @

Description
Parameter Description
Low Latency Turn on of turn off the function.
o @ 0n
The device latency can be reduced by 1 frame.
o O off

5.4.2.3 Set Canvas Size

Prerequisites
None
Notes

None
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Interface Example

v Canvas Settings
Configured Cabinet 576 * 216
Resolution Custom
Wwasd | | H2160

Max. Frame Rate T5.00HZ

Match Screen |

Description

On the Basic tab interface, configure the following parameters.

Parameter Description

Resolution The size of the canvas, that is the size of the device effective loading area
Config method:
® Select the desired resolution from the drop-down list.

® Select Custom from the drop-down list, and then set the width and height
values.

Generally, the size of the effective loading area should match with that of the

physical screen.

After you complete the settings, the system will automatically calculate the max

output frame rate at the current resolution.

Match Screen After the screen configuration is completed, click Match Screen and the system
will automatically change the canvas size to the size of the circumscribed

rectangles.

5.4.2.4 Configure Test Patterns

Test patterns are used to check the connection relation between the output connectors and the
screen, and check whether the screen display is good.

Prerequisites

None
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Notes

None

Interface Example

* Test Pattern

Brighiness

Spacing (px)

Description

On the Basic tab interface, configure the following parameters.

Parameter Description
Test Pattern Turn on or turn off the function.
o @ 0n
o (. off
After the function is enabled, select the desired test pattern.
Brightness Set the brightness of the test pattern.
Spacing Level Set the spacing between different color areas.

If a multi-color test pattern is selected, this parameter is available.

Spacing (px) Set the spacing between the lines.

If a grid test pattern is selected, this parameter is available.

Grid Width Set the width of the grid lines.

Speed Set the moving speed of the lines.
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5.4.2.5 Configure Output Color

Configure the output color parameters.

Prerequisites

None

Notes

Note
Interface Example
v Color
Conirast «—
Conirast R«

Conirast G«

Conirast B«

Brightness
Brightness R «—

Brightness G «—

Brightness B«

Saturation «—

Description

On the Effect tab interface, configure the following parameters.
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Parameter Description

Contrast The ratio of the luminance of the brightest color to that of the darkest color
Adjust the contrast value either as a whole or individually adjust the RGB
components.

Brightness The shading of lights in the image
Adjust the brightness value either as a whole or individually adjust the RGB
components.

Hue The relative degree of how bright or dark the image is

Saturation The color purity of the image
The higher the value, the more vivid the color.

5.4.3 Configure Cabinet Properties

5.4.3.1 View Cabinet Info

View cabinet-related info.

Prerequisites

None

Notes

None

Interface Example

* Cabinet

Manufacturer
Moded

Cabinet Size

Pixel Pitch

Cabinet Resolution
Module Resolution

Other

A10s Pro

192=216 px

96=108 px

>
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Description

None

5.4.3.2 Configure Cabinet Groups

Change the cabinet group name and background color.
Prerequisites

A cabinet group has been created.
Notes

None

Interface Example

v Cabinet Group

Name

Color

Description

On the Cabinet Properties tab interface, configure the following parameters.

Parameter Description

Name The name of the cabinet group

Config method: Enter a new group name, and then click elsewhere in the

interface to complete the group name change.

Color The background color of the group name

Config method: Click the color block next to Group Color, and then select a
standard color or enter RGB values to set the background color of the cabinet

group name.
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5.4.3.3 Configure Cabinet Positions

Prerequisites

None

Notes

The cabinet rotation in 90° increments feature is only supported by certain models of receiving

cards, as detailed below:

Model Description
CA50E, XA50Pro, A10s Pro Supported by all versions.
A8s-N, A7s Plus, A5s Plus Supported by V4.9.0.0 or later.

Interface Example

* Cabinet Position

Coordinates

X 0

Rotation (07)

Description

On the Cabinet Properties tab interface, configure the following parameters.

Parameter

Description

Coordinates

The position of the cabinet on the canvas
® X: X coordinate of the cabinet on the canvas

® Y:Y coordinate of the cabinet on the canvas

Rotation (0°)

Rotate the cabinet. Once the cabinet is rotated, the input source will display at

the adjusted angle.

Supported rotation angles: 0°, 90°, 180° and 270°
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5.4.3.4 Set Cabinets

Prerequisites
None
Notes
None

Interface Example

“ Cabinet Settings

Blackout
Freeze
Indicator

Light up Slowly

Test Pattern ¢ Nommal

Mo Data Signal Previous Frame

Description

On the Cabinet Properties tab interface, configure the following parameters.

Parameter Description

Blackout Turn on or turn off the function.
° (): On
o O Off

Freeze Turn on or turn off the function.
. D: On
o OB Off

Indicator Turn on or turn off the function.
° (): On
o O Off

Light up Slowly Turn on or turn off the function.
e @:0n
o (O off
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Parameter Description

Once enabled, the display brightness will slowly change from 0 to the target value

after the screen is powered on.

Test Pattern Select a test pattern to perform screen aging test and troubleshoot problems.

No Data Signal Set the display image after the Ethernet cable is disconnected.
® Blackout: The screen displays a black image.

® Previous Frame: The screen always displays the last frame.

5.4.3.5 Configure Ethernet Port Backup

Test whether the pre-stored images, backup Ethernet ports and devices take effect without

plugging and unplugging the Ethernet cables.

Prerequisites

The pre-stored images, primary and backup Ethernet ports or primary and backup devices have

been configured.
Notes
None

Interface Example

v Ports Redundancy

Backup Test

Description

On the Cabinet Properties tab interface, configure the following parameters.

Parameter Description

Ports Redundancy | Turn on or turn off the function.
o @ 0n
o (. off
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Parameter

Description

Backup Test

Select the desired backup test.

® Off: Enable the output of all the Ethernet ports on the current device to
complete the test.

® Backup Only: Disable the output of the primary Ethernet port on the current
device to test whether the backup port or device takes effect.

® Primary Only: Disable the output of the backup Ethernet port on the current
device to test whether the output of the primary port is normal.

® Disconnect All: Disable the output of all the Ethernet ports on the current

device to test whether the pre-stored image takes effect.

E Note

After enabling Ethernet port backup, a icon is displayed between the primary and backup

ports in the Ethernet port list. By default, the first half of the ports serve as backups for the

second half.

5.5 Screen Settings

5.5.1 Adjust Image Quality

Adjust the Gamma value and brightness of the output to enhance the overall image quality of

the LED screen.

Prerequisites

None

Notes

None
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Interface Example

v Brightness Adjustment

Brighiness

@ 1000 %

Description

Select Screen Settings at the top of the page, and then on the Image Quality tab interface,

configure the following parameters.

Parameter Description
Brightness The brightness of the LED screen
Gamma Adjust the ratio of the screen brightness to the input level. The parameters are

read from the receiving card, which default to optimal values at the factory. It is

recommended the parameter adjustment be carried out by the trained personnel

when necessary.

5.5.2 Adjust Output

5.5.2.1 Configure 3D

Directly connect a third-party 3D emitter using the device's built-in 3D connector, or connect to
the EMT200 emitter via the device's Ethernet port. Then, use the compatible 3D glasses to
achieve a 3D display effect.

Prerequisites

® Video source format: Side-by side, top-and-bottom or frame sequential.

® \When paired with the EMT200, it is recommended to use a 3D source of 60Hz to enjoy an

optimal experience.

Notes

® Enabling the 3D function will halve the device output capacity.
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® The 3D function and input cropping cannot be enabled at the same time.

® After enabling the 3D function on the Screen Settings page, 3D switches of all the layers will

be toggled on. If you want to use a 2D layer, please toggle off the 3D switch of the desired

layer in the property area of the Programming page.

® The 3D effect follows the layer. The output area where a 3D layer is located always displays

the 3D effect.

Interface Example

v 3D O

Source Format

Eye Priority

Third-party Transmitter

Emitter Delay

Description

Side-by-Side

Left

On the Output tab interface, configure the following parameters.

Parameter

Description

3D

Turn on or turn off the 3D function.
o O: On
o OB Off

Source Format

The format of the 3D video source

Set the format to Side-by-Side, Top-and-Bottom or Frame Sequential according to

the format of the accessed video source.

Eye Priority

Set which image is sent first, the right eye image or the left eye image.

Put on the 3D glasses to view the screen. If the display appears abnormal, adjust the
parameter value to the other one. If the display is normal, no further adjustments are

needed.

Third-Party

Emitter

Turn on or turn off the function.
o O: On
o (W Off

Emitter Delay

Set the delay time of sending the synchronization signal from the 3D signal emitter to
the 3D glasses. This setting ensures that the switching between left and right eye
images of the 3D glasses is in sync with the switching between the left and right eye

images on the screen. This parameter is applicable to both the NovaStar and third-
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Parameter Description
party emitters.
5.5.2.2 Check Load

Check the capacity usage of each Ethernet port of the device.

Prerequisites

None

Notes

None

Interface Example

* Port Load

Device 1

1
2
3
4
5
6
7
]
9
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Description

On the Output tab interface, click H next to the device information to check the usage of the

device loading capacity.

5.6 Layer Operations

5.6.1 Add Layers

Add layers to screen
Prerequisites
Make sure the device is in Video Controller mode before adding layers.

Notes

The maximum number of layers that can be added depends on the connected device.

Device Model Number of Supported Layers (2Kx1K)
VX2000 Pro 12

VX1000 Pro 6

VX600 Pro 6

VX400 Pro 6

Operating Procedure

Step 1 Select a device on the left side of the interface and then click Programming at the top of the

page.
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Figure 5-13 Programming (VX2000 Pro)

Step 2 Add the layers to the screen.
Drag an input source in the input list to the screen.
Step 3 Perform the desired layer operations as required.

Figure 5-14 Layer operations

1 Lock/unlock layer

2 Pixel-to-pixel display
3 Fill entire screen

4 Fill canvas

5 Follow canvas

6 Delete layer

7 Zoom Out

8 ZoomIn

9 Zoom to Selection

10 Auto fit

11 Clear

12 Lock/unlock canvas
13 Bring forward

14 Send backward

15 Bring to front

16 Send to back

17 Fill herizentally

18 Fill vertically

19 Fill entire screen

20 Aligntop

21 Outputimage brighness
22 Layer source volume
23FTB

24 Freez/unfreeze

i @ Eme

mOn 7 @) e @ Crrre) @
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5.6.2 Configure Video Source Properties

In the input list, select an input source and set the relevant properties on the right pane. For

detailed configurations and parameter descriptions, please refer to Configure Input Properties.

5.6.3 Mosaic Source Settings

Both HDMI and OPT sources support mosaicing.

5.6.3.1 View Mosaic Source Info

View the basic properties of the mosaic source and change the source name.
Prerequisites

A mosaic source has been configured and its signal is fine.
Notes

None
Interface Example

v Mosaic Source Info

Name MOSAIC -1
Resolution 19201080
Frame Rate 30

Connector Capacity SL

Mosaic Template |:|

~ HDMI-1
Type HDMI 2.0
Resolution & 38402160 px
Frame Rate 30 Hz

Color/Sample RGE 444

Metadata >
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Description

On the Mosaic tab, type in a new source name and click anywhere else on the interface to save
the change.

5.6.3.2 Configure Mosaic Sources

Set the mosaic source name, sub-source type, mosaic layout as well as sub-source size.
Prerequisites

None
Notes

Only the input sources of the same connector type support mosaicing, and the frame rates of
sub-source must be the same.

Interface Example

Vv Mosaic Settings
Name MOSAIC 1
Source type HDMI 2.0

Layout

Sub-Source Size

Width 1920 % Height 1020

Description

On the Edit Mosaic tab interface, configure the following parameters.

Parameter Name Description

Name The name of the mosaic source

Source Type The type of the sub-sources

Config method: Select HDMI 1.3, HDMI 2.0 or OPT from the drop-down list.

Layout The layout of the mosaic source
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Parameter Name | Description

Config method: Select the desired layout from the standard layout template, and

then drag the inputs in the input list to the sub-cells respectively.

Sub-Source Size The size of the sub-sources

® Default width: 1920 pixels, max width: 8192 pixels
® Default height: 1080 pixels, max height: 8192 pixels
® Max width and height: 4096x2160

5.6.4 Configure USB Source Properties

Select a USB source in the input list and configure relevant properties on the USB Playback

Settings tab interface.

The models of devices that support USB playback and the corresponding output resolutions for

USB sources are listed below.

Device Model USB Source Resolution
VX2000 Pro 3840%x2160@60Hz
VX1000 Pro 1920x1080@60Hz
VX600 Pro

VX400 Pro

5.6.4.1 Play USB Files

Prerequisites

The U-DISK connector on the front panel is inserted with a USB drive which is successfully
identified.

Notes

None
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Interface Example

v Playlist

1.bmp
2 bmp
3.bmp

313

Description

In the playlist, select a file to play it and you can also stop the playback, play the previous or

next file as well as set the playback mode.

5.6.4.2 Configure Playback Parameters

Prerequisites

The U-DISK connector on the front panel is inserted with a USB drive which is successfully
identified.

Notes

None

Interface Example

v Playback Settings

Playback Mode

File Type

Playback Duration 3

Trans Effect Curtains

Trans Duration 1.0

Auto Playback

Resume Playback

Capacity
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Description

On the Settings tab interface, configure the following parameters.

Parameter Description
Playback Mode The playback mode of the file
® Repeat: Play the files in the playlist in order. Once the playback of
the last file is completed, replay the first file.
® Repeat in Order: Play the files in the playlist in order. Once the
playback of the last file is completed, the screen will display a black
image and the playback will stop.
® Repeat One: Loop playback of the current file.
File Type The type of the playback file

* Video
® Image

® All: Video and Image

E Note

After the file type is selected, only the file of the selected type will be
displayed in the playlist.

Playback Duration

The duration of the image playback

The value ranges from 1 to 60 and it defaults to 5. (Unit: s)

Trans Effect

The trans effect of the image

Supported trans effect: Ripple, zoom in, push, flip, blinds, H wipe, V
wipe, cube, dissolve, grid, swapping, scroll, fade in/out, twirl, heart

trans, curtains, perspective triangle, disappear, bounce, star rotation

Trans Duration

The trans duration of the image

The value ranges from 0.5 to 2 and it defaults to 0.5. (Unit: s)

Auto Playback

The auto playback switch

Set whether to automatically play the USB files after the device is

powered off and then power on with a USB drive inserted.
o @ 0n
If Resume Playback not enabled, replay the files in the playlist in

order; If enabled, replay the file being played before power failure

from the beginning.

o C: off

Resume Playback

Turn on or turn off the function.
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Parameter

Description

o« @ 0n

If a file is playing before the device power failure, enabling this
function allows to replay the file from beginning after the device is

powered on with a USB drive inserted.

o (Woff:

Replay the files in the playlist in order.

Q Note

® Enabling Resume Playback will also activate the Auto Playback

feature at the same time.

® After Resume Playback is enabled, if the file being played before
power failure cannot be found, the files will be played from the

beginning of the playlist in order.

5.6.5 Configure Layer Properties

Select the desired layer, and then set the layer-related properties in the property area on the

right pane.

5.6.5.1 Configure Basic Properties

Configure the layer name, aspect ratio, position, size, as well as enabling the 3D effect.

Prerequisites

None

Notes

After enabling the 3D function on the Screen Settings page, 3D switches of all the layers will be

toggled on. If you want to use a 2D layer, please toggle off the 3D switch of the desired layer in

the property area of the Programming page.
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Interface Example

Video Layer
L1

Aspect Ratio

Vv Position & Size

Description

On the Basic tab interface, configure the following parameters.

Parameter | Description

Name The layer name
Aspect The ratio of the layer's width to its height
Ratio

After the aspect ratio is changed, the height of the layer remains unchanged, and the

device automatically calculates its width.

X The horizontal starting position of the layer on the screen

The coordinates of the first pixel in the upper left corner of the screen are (0,0).

Y The vertical starting position of the layer on the screen

The coordinates of the first pixel in the upper left corner of the screen are (0,0).

w The horizontal size of the layer

The minimum width of a layer: 64 pixels

H The vertical size of the layer

The minimum height of a layer: 64 pixels

3D Turn on or turn off the function
o (): On
o O Off
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5.6.5.2 Crop Layer Sources

When there are black borders or other redundant info in the input source image, the required
picture can be retained through the cropping the input source, so as to improve the screen
utilization.

Prerequisites
A fine signal is connected to the input connector.

Notes

® The status and capacity of the cropped source remain consistent with the original one.

® The input cropping and 3D functions cannot be enabled at the same time.

Interface Example

v Layer Source Crop

Description

On the Advanced tab interface, configure the following parameters.

Parameter Description
Layer Source Turn on or turn off the function.
Crop o @ 0n
o CI: off
X The horizontal start position of the cropped area relative to the original source
Y The vertical start position of the cropped area relative to the original source
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Parameter Description
Width The number of horizontal pixels (width) of the cropped area
Height The number of vertical pixels (height) of the cropped area

5.6.6 Manage Presets

To manage the presets, click Preset on the right side of the Programming interface and perform

the corresponding actions as needed.

Save Presets

Step 1 On the Preset tab interface, click Save Preset at the bottom, and then a pop-up window will

appear showing the preset numbers.

Figure 5-15 Bind presets (VX2000 Pro)

Step 2 In the Bind Key window, select the desired key number to save the current layer information to

the preset.

One key number corresponds to one preset. The name of the save preset: Preset X ("X" refers to

the bound key number.)

Load Presets

In the preset list, select the desired preset to load it.
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After the preset is successfully loaded, the corresponding indicator light at the top left of the
preview area will light up:

® @:The preset is not loaded.

® &: The preset is loaded.

Rename Presets

Place the mouse over the preset and click . Enter a new name and then click elsewhere to
make the change take effect.

Delete Single Presets

Place the mouse over the preset and click ﬂ In the pop-up dialog box, click Yes.
Delete All Presets

Click Edit, check Select All, and click . In the pop-up dialog box, click Yes.

5.7 Maintenance

5.7.1 Device Maintenance

In the menu bar, select Maintain. Select the Device tab and the target devices, and then do the

following as required.
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Figure 5-16 Device maintenance (VX2000 Pro)

Restart

Click Restart. In the displayed dialog box, click Yes to restart the device.

Factory Reset

o Cautior

e Please do this with great caution.
e The reset action does not affect the device firmware version.
e Power-off is NOT allowed during the reset process.

e The device will restart automatically after the reset is completed.

Click Factory Reset. In the pop-up dialog box, select Keep user data or Reset all, and then
click OK.

® Keep user data

Retain the device IP address, input connector EDID, gallery files, device language settings,

device name and belonged project.
® Reset all

Retain the device IP address and belonged project.
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Figure 5-17 Factory reset

Factory Reset

Please select a factory reset method:
Keep user data

Reset all

Export Logs

Click Export Log. In the dialog box that appears, select a path and click Save to save the device

logs to local computer.

5.7.2 Device Diagnostics

In the menu bar, select Maintain. Select the Diagnostics tab, select a device from the drop-

down list, and click Diagnostics.

After the diagnostics completes, you can view the test result and take necessary measures as

required.

Figure 5-18 Device diagnostics (VX2000 Pro)
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5.8 Other Settings

5.8.1 Switch Ul Language

In the menu bar, go to Settings > Language to switch the Ul language.

5.8.2 Export Logs

In the menu bar, go to Settings > Export Log to export the logs.

5.8.3 Configure Device Backup

Device backup allows you to set the backup relationship between two devices. You can set one
of the devices as the primary device or the backup device. When the primary device has a
problem or the primary device's Ethernet cable fails, the backup device will take over the
responsibilities of the primary device seamlessly and continue to work well to ensure the LED
screen will not go black.

Prerequisites

® Before creating a backup relation, make sure that both the primary and backup devices are
on the same LAN.

® In a backup relation, the models and device versions of the primary and backup devices must
be the same.

Notes

® You have three options to create a backup relation: NovaLCT, Unico web page, or the device
LCD menu. However, be aware that these methods do not synchronize with each other.
Using more than one can lead to data problems. To prevent issues, choose only one method
for setting up your backup. If you do mix them, you'll need to reset the device to factory
settings and start over with just one method.

® |n the device backup mode, the quantity of the cabinets loaded by each Ethernet port on
both the primary and backup devices must be the same, but their data flow must be in a

reversed way.
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Operation Procedure

Step 1 In the menu bar, go to Settings > Device Backup.
Step 2 In the pop-up window, click Add to add a backup relation.

Figure 5-19 Add backup relations
Device Backup X
d firmware versions of the primary device and ba jice are the same before a

_ . ) device-upgrade- _
Primary Device Backup Device : - Action
static-version

Step 3 Select the primary and backup devices from the drop-down lists respectively.

After the action completes, the firmware versions of the primary and backup devices will be
displayed.

Step 4 Click OK to complete the backup relation settings.

Step 5 (Optional) Click Delete to delete the desired backup relation.

5.8.4 Manage Cabinet Library

In the menu bar, go to Settings > Cabinet Library. Do the followings as needed to manage the
cabinet library files.
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< Back Cabinet Library

+ Aol 3 Rsmowe

Dawic Pasch {281

Mame

1

Upload Cabinet Files

Step 1 Click Add and select the cabinet type in the displayed window.
Figure 5-20 Cabinet file
Add

Type Cabinet File (rcigx)

Import File  Device Pack

Import (& upioad )
Objects

Step 2 Select the .rcgx file to be imported from the local computer and click Upload.

After the file is selected, you can click Delete to delete the uploaded file.

Export Cabinet Files

Step 1 Select one or more files on the Cabinet Library interface and then click Export.
For batch export, multiple files will be compressed as a .zip file and exported.

Step 2 Select a local directory and click Save.
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Sync Cabinet Files

® Sync cabinet files between devices

1) Select the files to be synced (multiple files can be selected), and click Sync Cabinet

Library.

2) On the displayed window, select the devices to which the files are synced (multiple

devices can be selected).

Sync Cabinet Library

Device Name IP Address

Device 1 192.168.0.108

3) Click OK.
View Cabinet and Flash Info

Select a cabinet file, and the information about all the cabinets that use this cabinet file will be

displayed.

5.8.5 Configure Preferences
In the menu bar, navigate to Settings > Preferences. Turn on the desired features (checked "v")

or off (unchecked).

® Screen Resources: Show the layer resources on the Programming interface if enabled.

5.8.6 Help

In the menu bar, go to Help > About Us to view the related info.
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Copyright © 2025 Xi'an NovaStar Tech Co., Ltd. All Rights Reserved.
No part of this document may be copied, reproduced, extracted or transmitted in any form or by any means

without the prior written consent of Xi'an NovaStar Tech Co., Ltd.

Trademark
I\IDVAJ)STAR is atrademark of Xi'an NovaStar Tech Co., Ltd.

Statement

Thank you for choosing NovaStar's product. This document is intended to help you understand and use the
product. For accuracy and reliability, NovaStar may make improvements and/or changes to this document at
any time and without notice. If you experience any problems in use or have any suggestions, please contact us
via the contact information given in this document. We will do our best to solve any issues, as well as evaluate
and implement any suggestions.

Official website
www.novastar.tech

Technical support
support@novastar.tech
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